HyperRESEARCH Tutorials

These tutorials provide instructions that will lead you step by step through the procedures used in analyzing data with HyperRESEARCH. Before you begin the tutorials, please read the “Getting Started” section in the HyperRESEARCH Help (accessed through the Help menu). HyperRESEARCH should already be installed on your computer.

These tutorials use the sample “Qualitative Data Analysis Study” and “Cinderella Study” files, which are included in the “Documentation” folder. The tutorial materials consist of prepared source files (including text, audio, video, and graphic files) and sample studies (including study files, saved reports, and saved theories) for you to use while familiarizing yourself with HyperRESEARCH.

We suggest you work with the tutorial files before starting a study with your own data, since this will allow you to learn how to use HyperRESEARCH without worrying about “messing up” any of your own research.

Topics covered in these tutorials are:

Tutorial One  Beginning a Study
Tutorial Two  Working with Codes
Tutorial Three Working with Cases
Tutorial Four  Analyzing Codes and Reporting

HyperRESEARCH Tutorials

About the Tutorials
HyperRESEARCH Tutorials

Tutorial Five  Working with Graphic, Video, and Audio Source Materials
Tutorial Six  Advanced Code and Retrieve Features
             (Autocoding, Code Proximity Functions, and the Code Map)
Tutorial Seven  Testing Theories

These tutorials assume you are already familiar with operating in the Macintosh or Windows environment – including using the mouse, clicking and double-clicking, opening and closing files, navigating through folders (sub-directories), etc. If you are new to this environment, refer to your Macintosh or Windows user guide.

Note: Most screen shots (illustrations) appearing in these tutorials were produced on a computer running the Windows operating system and portray HyperRESEARCH as it appears in the Windows environment. Some of HyperRESEARCH’s screens will look different on Mac OS X. In most cases, these differences are cosmetic only. Differences in functionality are explained in the text.

About the QDA Study

A number of qualitative researchers have raised questions regarding the effect of QDA software in the research process. Some claim that the structure of these programs may demand that the data be analyzed in a certain way. Others argue that these programs will discourage in-depth analysis of the data in favor of large sample sizes in order to make generalizations in their data. The QDA Study addresses these issues and others through interviews with qualitative researchers in sociology and organization behavior who regularly used or had used QDA software: the Ethnograph, HyperRESEARCH, and other similar products. There is little research into how users’ actually experience QDA software (see Lee and Fielding, 1995) and this study provides some useful insights into users’ experiences with QDA software. This research was originally published in Social Science Computer Review in 1996 (see Smith and Hesse-Biber, 1996). The sample QDA Study included with HyperRESEARCH presents six cases (out of the original 12).


About the Cinderella Study

Dr. Sharlene Hesse-Biber collected the data for the sample Cinderella Study used to demonstrate HyperRESEARCH. The subjects are undergraduate female students of qualitative sociology at Boston College. These women describe what they hope their lives will be like 20 years in the future, when they will be about 40 years old. The essays in this study are used with the subjects’ consent.
HyperRESEARCH Tutorials

The sample study proposes that a majority of college age women have idealistic views of their futures. From the material presented in this sample study, you will soon see why we called it the Cinderella Project.

Note: The Cinderella Study material is not a fully developed research study; it is intended solely as sample material to illustrate HyperRESEARCH.
HyperRESEARCH Tutorials

Tutorial One: Beginning a Study

HyperRESEARCH Tutorials ................................................................. 1
  About the QDA Study ................................................................. 2
  About the Cinderella Study ......................................................... 2
Tutorial One: Beginning a Study ...................................................... 4
  Launching HyperRESEARCH ..................................................... 4
  The Study Window .................................................................. 5
  Creating Your First Case ......................................................... 6
  Opening a Source File ............................................................... 8
  Checking Source Material ....................................................... 9
  Coding Source Material ............................................................. 11
    Customizing the Display ....................................................... 14
    Continuing to Code .............................................................. 14
    Display Codes in Context ..................................................... 15
  Assigning Multiple Codes ....................................................... 17
  Recalling Underlying Passages .................................................. 18
  Refining Our Coding ............................................................... 19
  Browsing Through Codes ....................................................... 22
  Creating a New Case ............................................................... 23
Saving the Study .......................................................................... 24
  Exiting HyperRESEARCH ....................................................... 25
For More Information ................................................................. 26

Launching HyperRESEARCH

Launch Hyper-RESEARCH

Macintosh: Launch HyperRESEARCH by double-clicking on the application’s icon in the HyperRESEARCH folder.

Windows: From the “Start” menu, choose “Programs,” then “HyperRESEARCH,” then the HyperRESEARCH application.

HyperRESEARCH will bring up the welcome screen, followed shortly by the License HyperRESEARCH dialog box. (This dialog box will not appear if you have already entered a license code for your copy of HyperRESEARCH.) You may enter your name, organization (if applicable), and license code now if you wish, then click the "Unlock" button to proceed. Otherwise click the "Use Free Limited Edition" button to access the program in free mode.

Note: If you see an error message saying that the code is invalid, try the following:

If you're copying and pasting the code, make sure to select only the code itself. Check that you haven't accidentally selected a space or return
HyperRESEARCH Tutorials

character before or after the code. These are easy to miss, and they can cause the code to be rejected.

If you're typing the code, make sure all the letters are lowercase, and be careful about letters and numbers that look similar (such as number 1 and letter "l"). In some fonts, these characters are hard to tell apart.

HyperRESEARCH brings up the “Welcome to HyperRESEARCH” dialog box, where you can choose to create a new, untitled study; open a recent study (the most recently accessed studies will appear in the drop-down menu); or open another study.

For Tutorial 1, please click “HyperRESEARCH Study” under “Create New”.

HyperRESEARCH now opens two windows, the Study window (currently labeled "Untitled") and the Code Book. Both are empty, as this is a new study that has not yet had any codes created or applied.

The Study Window

The Study window (currently “Untitled”) is the main window for your HyperRESEARCH study. The Study window keeps track of cases and code references. You can use the “Filter Cases” and “Filter Codes” options to customize the information that the Study window displays. You can also use the Study window interface to navigate through your cases and your code references. You can choose to view all the information for applied codes (Code Name, Source, Type, and Reference) or simplify the display to show only the Code Name for codes applied to the current case. (Click on the arrow to the right of the “Code Name” / “Source” / “Type” / “Reference” line to toggle between the full display and the simplified display.)
Creating Your First Case

Cases Menu: Rename

We’ll use the Untitled Case Card presented when we first open HyperRESEARCH to start our study — but first, we’ll give it a name.

Choose “Rename…” from the Cases menu. (HyperRESEARCH must have at least one case in any open study, which is why we “Rename” the Untitled case rather than deleting it.)

Enter “Manga”

HyperRESEARCH brings up a Case Name dialog box, with the name “Untitled” highlighted. Type in “Manga” and click the “OK” button (or press Return or Enter).

HyperRESEARCH returns you to the Study window, with the first case now titled “Manga” rather than “Untitled.”
Opening a Source File

Choose the “Open Text File” command from the Sources menu.

HyperRESEARCH brings up a standard Open File dialog box.

Locate the file named “manga.txt” included with the QDA Study. It should be in the “QDA Study Sources” folder with the following file path:

HyperRESEARCH/Documentation/Tutorials/QDA Study/QDA Study Sources

Once you’ve located the Manga interview, select and open it.

If you’re not sure how to use the dialog box to locate folders (directories) and files, please refer to your computer’s user manual.
HyperRESEARCH opens the Source window and displays the Manga interview.

Checking Source Material

We advise you to double-check each source file when you first open it, before you begin coding. (Once you begin coding a source file, changing or modifying the file may affect the coding you’ve done, rendering it meaningless.) So let’s browse the Manga source file, looking for any potential trouble-spots before we begin coding.

Readability is the main thing to check for when you first open a source file. Many things can affect readability.

Font Settings

If you don't like the font or font size of the text displayed in the Source window, use the Font Settings button at the top of the window to alter the font and/or size HyperRESEARCH uses to display the text. Feel free to play around with various font and size combinations until you get a combination that displays well on your screen.

Editing for Readability

Other readability issues must be dealt with during the text source preparation stage rather than within HyperRESEARCH itself. The use of “white space” (blank lines between paragraphs) to signal breaks in the text is a good example.

Some of the paragraphs in the Manga interview transcription are quite long and may be difficult to read. In transcribing the interview, the only breaks introduced into the text were those inserted when the speaker changed.

To make text more readable (which will help tremendously in coding the text file), edit the original text file before beginning to code. Simply breaking the longer responses up into multiple paragraphs (and relying on the use of tags such as “J -” or “S – ” to show a change in speaker) should improve things.

It’s also a good idea to do a final check for spelling and other errors in the source file at this point. Correcting problems in the source file becomes problematic after we begin coding.

Important! Remember that you must not edit a source file after you begin coding that source file. Changes to the contents of a source file may alter the source material a code reference points to.
HyperRESEARCH Tutorials

If you wish to practice editing source files, you may edit the original, unsatisfactory “Manga” file. Exit HyperRESEARCH and open the “Manga.txt” file in your favorite word processor. Insert extra paragraph marks to break up the text. Be sure to save the file in text-only format; rename it “MyManga” or “mymanga.txt.” Then exit the word processor, launch HyperRESEARCH again, open the edited source file, and continue with the tutorial.

The tutorial files provided with HyperRESEARCH include a version of the “Manga” interview in which we have already addressed the readability issues (“manga2.txt” or “Manga 2,” in the QDA Sources folder). We inserted extra lines between paragraphs, which should make the file easier to read. You may use this “Manga 2” source file to continue the tutorials.
Coding Source Material

Open Source File

Open the “manga2.txt” (“Manga2”), using the “Open Text File” command in the Sources menu. (Alternatively, you may open a version of the “Manga” file you yourself have edited.)

Select Passage

With the edited version of the Manga interview (“Manga2”) open, let’s code a passage.

Locate the paragraph beginning with “J-Well, I initially found out about it….” (You may need to scroll down a page if using a low-resolution monitor setting. It’s the fifth paragraph in the file.)

We’re interested in coding the first two sentences (“J - Well, I initially found out about it using computers in the class I took with you five years ago. And we had exercises to do where we had to analyze an interview, so we did kind of an exercise.”).

To select this passage, click and drag over the text in the first two sentences.

Activate the Code Book to create and apply a code to the selected material.

Note: The Code Book may automatically activate when you select text. The Options dialog box (available via the Edit menu) has a Coding option that allows you to determine the Code Book’s behavior. You may set the Code Book to activate automatically as soon as you’ve selected some source material to code (the “On Selecting” option). Or you may set it to activate “On Return or Enter,” which allows you to
easily select and re-select source material until you have exactly the chunk of text or graphic you wish before activating the Code Book). Feel free to experiment with these two options to see which method you prefer.

If the Code Book is not set to activate automatically when you select material in the Source window, you may activate the Code Book in the following ways:

- Click anywhere within the Code Book. (If you prefer, you can immediately select the “New Code…” command from the Edit Code menu button in the Code Book to proceed directly to creating a new code.)

- After selecting text in the text Source window, press “Return” (Macintosh) or “Enter” (Windows), or choose the “Encode…” command in the Codes menu.

HyperRESEARCH activates the Code Book window. (You can tell which window is the current “active” window by looking at the title bar. The title bars of inactive windows are greyed out.) If the Code Book is not open, HyperRESEARCH will open it for you.

There are no codes listed in the Code Book, as you have not yet created any.

Create a “New Code…”

Select the “New Code…” command from the "Edit Code" menu in the Code Book window to create your first code.
HyperRESEARCH Tutorials

HyperRESEARCH brings up a Create New Code dialog box. Type in the code name *learned about QDA software in class* and click “OK.”

HyperRESEARCH returns you to the Code Book, with the code *learned about QDA software in class* now part of your code list.

**Assign Code**

Assign the code *learned about QDA software in class* to the selected text passage. Make sure the correct material is selected in the source window, and that the correct code is highlighted in the Code Book, then click “Apply Code.” Or double-click the code name to assign it to the selected text. Or, with the code name highlighted in the Code Book and a selection of text highlighted in the source window, press Enter or Return to apply the code.

HyperRESEARCH adds the code *learned about QDA software in class* to the case currently viewed in the study window.

Your HyperRESEARCH screen should now look something like this:
HyperRESEARCH Tutorials

Customizing the Display

**Default Window Layouts**

HyperRESEARCH provides several default window layouts. You may choose the layout that best suits your needs from the Windows menu.

**Default Layout 1**

Default Layout 1 places the Code Book centrally on your screen, maximizing its height (and hence the number of codes you can see on screen at once). The Study window shows the full code reference, including the code name, source file name, source type, and positional reference.

**Default Layout 2**

Default Layout 2 places the Code Book in the lower left, where the Annotation window also goes. (See *Tutorial 2: Working with Codes* for more information.) This increases the amount of space available for the source window. In this configuration, the Code Book and Annotation window share the same space, with whichever window is foremost hiding the other. (You can easily activate the window you need, by choosing “Annotate…” or “Code Book” from the Codes menu or by choosing the appropriate window from the Window menu.)

**Default Layout 3**

Default Layout 3 maximizes the space used by the Source window. As with Default Layout 2, the Code Book and Annotation window occupy the same space. In this configuration, the study window shows only the code names applied to the case, rather than the full code reference (see *Default Layout 1*, above).

**Experimenting with Layouts**

You may want to experiment with the default layouts to find one that works best for you. As all windows are movable and resizable, you may also create your own preferred layout. Once you have the windows arranged to your liking, choose “Preferences…” from the Edit menu. Click the “Program” tab to bring the program preferences to the forefront. Uncheck the “Startup with Default Windows Positions” option. When you re-launch HyperRESEARCH for future sessions, it will remember the positioning of the windows when you last exited the program.

Continuing to Code

Let’s code another passage: one further on in the source file.

**Edit Menu:**

Make sure the source window is active. Click the source window to
HyperRESEARCH Tutorials

Find “By hand”

make it active if it isn’t already.

Choose the “Find…” command from the Edit menu. Under "Text to find:" enter “By hand”. This should bring you to a paragraph that reads “S – By hand…."

If the “Find…” command is unavailable (grayed out), click in the source window to make that window the current active window. The “Find…” command should then be available.

Select 2 paragraphs

Select both paragraphs: Sharlene’s question (“By hand…”) and Julie’s response (“J - By hand. So I did an analysis of one, and then I did the analysis of the next one, kind of comparing it to the first one. Ok, what are the differences here.”)

Encode

The Code Book will become the active window. (If it does not, press Return or Enter to activate the Code Book. Or click the Code Book window to activate it.)

Create New Code: "used hand methods"


Enter a new code, named used hand methods, and click “OK” (or press Return or Enter).

Assign to selected passage

With the new code used hand methods highlighted in the Code Book (click it if it’s not), click “Apply Code” to apply the code (or press Return or Enter).

Your study window should now list two code references for the “Manga” case; learned about QDA software in class and used hand methods.

Display Codes in Context
HyperRESEARCH Tutorials

The “Display Codes in Context” checkbox at the bottom of the source window allows you to choose to display the code names in a margin to the left of the source material they’re assigned to. Turn this feature off if you wish the entire source window to be devoted to displaying the text.

Click the "Display Codes in Context" box to activate this feature. (If it’s already active, clicking on this box will deactivate it.)

The left margin shows code names that have been applied to the text. The main portion of the window, to the right, displays the source text. The divider bar between the two columns is moveable; simply click it and drag it to the left to make the left column narrower or to the right to widen it (which in turns narrows the column containing the source text).

Click on one of the code references in the study window to see the corresponding code and source material highlighted in the source window. Alternatively, click one of the code names in the left margin of the source window to see the relevant source material highlighted, as well as the corresponding code reference in the study window.
Assigning Multiple Codes

**Edit Menu:**

Find
"creative"

Let’s locate another passage to code. Click the source window to activate it (if it's not already active). Use the Find command (Command-F for Macintosh, CTRL-F for Windows) and search for the word "creative". This should bring you to a paragraph that begins “S - Do you think that using the tool helps you be more creative as a researcher or not?”

**Select 5 paragraphs**

Select five paragraphs beginning with this one, so the source material selection includes everything from "S – Do you think…” to Julie’s two-paragraph response, ending in “What I do is give a reminder to myself, and those initial reports are really where the heart of the direction for my dissertation comes in.”

If the chunk of text you’re selecting runs off the bottom of the source window, continue to hold the mouse button down while positioning the cursor at the bottom of the page. The page will automatically scroll down until you can select the rest of the passage.

**Encode:**

computer as creativity tool, flexibility of software important

This time we’ll assign two codes to the same passage. Choose “New Code” from the Edit Code pull-down menu in the Code Book window. (If the Code Book has been closed for any reason, choose “Code Book” from the Codes menu to open it.)

Create a new code, *computer as creativity tool*. Create another new code, *flexibility of software important*. Select both these code names (hold down the Shift or Control key — Command key on the Macintosh — to select both) and apply them to the passage you selected in the source window.
The study window for the Manga case should now show four codes; *learned about QDA software in class, used hand methods, computer as creativity tool, and flexibility of software important.*

The source window should still show the Manga interview (or the edited version, either the one you edited yourself or the “manga2.txt” or “Manga” interview included with the tutorial). If the “Codes in Context” option at the bottom of the source window is turned on (with a checkmark displayed in the checkbox), the window should show two columns, with code names displayed in the left column and the source material displayed in the right.

Now let’s learn how to recall the specific coded material on-screen.

### Recalling Underlying Passages

Let’s recall the passages we selected for coding and review the code names we chose.

**"View Source" option active**

First, make sure that the "View Source" option at the bottom of the Study window is checked (active). If not, click in it now; a checkmark should appear.

**Select flexibility of software important code**

Click the code reference on the study window that shows the last code, *flexibility of software important.*

HyperRESEARCH highlights the code reference and automatically updates the source window to show the underlying text (by changing the background color of the selected text). If you have the “Codes in Context” option active (see the bottom of the Source window) the code name, also highlighted, will appear in the margin to the left of
Refining Our Coding

Reviewing the passage we coded *flexibility of software important*, we can see that Julie felt using computer software for qualitative analysis really freed her up to do her coding. Let’s assign another code to this passage, *computer brings relief*.

When assigning another code to a passage previously coded, there’s no need to re-select the text. With the code reference for *flexibility of software* highlighted in the study window, choose “Duplicate” from the Codes menu. (Or use CTRL-D in Windows, Command-D on the Macintosh.)

The “Duplicate…” command allows you to duplicate the code reference and assign a different code name to it.
HyperRESEARCH Tutorials

HyperRESEARCH brings up the code selection dialog box, containing your list of codes.

Since none of the existing codes are what we’re looking for, we need to create a new code. Use the New Code… button in the code selection dialog box to create a new code: `computer brings relief`. (Click the New Code… button to call up the New Code dialog box. Note that this is a different button than the "New Code..." command in the Code Book, but it does the same thing.)

With this new `computer brings relief` code highlighted in the dialog
box, click “Select” (or press Return or Enter).

HyperRESEARCH brings up a dialog box that reads “Duplicate the highlighted code reference to ‘computer brings relief’ on the current case (Manga) ONLY?”

Click OK (or press Return or Enter) to apply the code computer brings relief to the same passage we earlier coded as computer as creativity tool and flexibility of software important.

Note: The dialog box message gives you a chance to cancel from the Duplicate function if you accidentally choose the wrong code name to assign to the passage. Plus, it serves as a reminder that there is also a global Duplicate… command available in the Code Book. The “global” Duplicate… command allows you to assign additional code names to duplicate passages throughout your study, not just one code reference at a time. See Tutorial 2: Working with Codes for more information.
The study window should now show *computer brings relief* as the last code reference. The original code references with the *computer as creativity tool* and *flexibility of software important* codes applied remain intact.

![HyperRESEARCH Tutorials](image)

**Browsing Through Codes**

Now, let’s browse through the other codes we’ve assigned.

*Select learned about QDA software in class code reference*

Click the first code reference, *learned about QDA software in class*, in the study window. (Please make sure the “View Source” option at the bottom of the study window is still active.) HyperRESEARCH highlights the code reference, and shows the underlying passage in the source window.

*Use up- and down-arrow keys to browse codes*

With the study window active (the title bar will be white or grayed out if the window is not active), use the down-arrow key to browse through your codes. As you press the down-arrow key, HyperRESEARCH highlights the next code reference and repositions the text within the source window to display the passage underlying that reference.

We could begin coding new passages at any time, simply by clicking on the source window to make it the active window and selecting the desired text.

That’s all the coding we’ll do for now. Click the source window’s close box to close the Manga interview.

There should be five code references in the Manga case now. Three of the codes will have identical information in the “Reference” column — this is the passage we originally assigned the *computer as creativity tool* and *flexibility of software important* codes and later duplicated to the *computer brings relief* code.
Creating a New Case

Before we save your work and quit this session of HyperRESEARCH, let’s get a new case ready for coding.

To create a new case, choose the “New…” command from the Cases menu.

HyperRESEARCH brings up the Case Name dialog box, where you can name the new case. Type in “Case 2” and click “OK” (or press Return).

HyperRESEARCH creates the new case and returns you to the study window, now showing the blank for Case 2.

Important! HyperRESEARCH offers several “new” commands. Use the “New Study” command in the File menu only if you wish to create an entirely new study, separate from the current study. Use the “New…” command in the Cases menu to create a new case for an additional “unit of study” in your current study.

A “unit of study” may be any division you wish: a person, a date, a group, a theme, etc. When determining what your “unit of study” will be, ask yourself what you wish to compare with what. If you wish to
HyperRESEARCH Tutorials

compare codes for Person A with codes for Person B, Person A and Person B should each have their own case. If you wish to compare codes for Group A with codes for Group B, all the people in Group A can go on one case while the members of Group B can go on another case, and so on.

If you wish more practice in coding source material, feel free to open any text file and select and code passages to the Case 2 case, just as you did for the “Manga” case. (Any coding you do is placed in the case which is currently visible in the study window.)

Saving the Study

Now, let’s save your work and end the HyperRESEARCH session.

**File Menu:**  
**Save**

Choose the “Save” command from the File menu. (This command may also be accessed from the keyboard, using the CTRL-S or Command-S keys.)

HyperRESEARCH presents you with a standard “Save File” dialog box, titled “Research Study Name.” Name the study “My QDA Study.hs2” and save it to your hard disk. You may use the folder/directory pull-down menu at the top of the dialog box to change the current folder or directory. Additional folders/directories within the current directory will appear in the main window. Enter the study name in the file name field.
HyperRESEARCH Tutorials

Note: Do not replace the “QDA Study” file that was installed with HyperRESEARCH; you will need the original QDA Study files for the other tutorials. (Naming the study you just created something like “My QDA Study” instead of simply “QDA Study” will avoid overwriting the original file.)

Exiting HyperRESEARCH

File Menu: Quit or Exit

Choose the “Exit” command from the File menu (on Mac OS X, choose “Quit HyperRESEARCH” from the HyperRESEARCH menu) to end this tutorial.

You may also exit HyperRESEARCH by clicking in the Close Box in the upper right corner of the HyperRESEARCH menu bar (in the Windows version) or in the upper left corner of the Study window (in the Mac OS X version).

Note: The other tutorials will utilize the sample QDA Study included on your HyperRESEARCH disk, rather than the study you created and saved in Tutorial One. You may use “My QDA Study” as a practice study if you wish, or you may delete it from your hard drive at the conclusion of this tutorial.
For More Information

For more information, we suggest you read the following sections in the HyperRESEARCH User Guide (accessed through the HyperRESEARCH Help menu):

Getting Started:
- Visual guide to HyperRESEARCH
- Quick start to coding
- How HyperRESEARCH works

HyperRESEARCH Reference:
- Windows:
  - Study window
  - Text source window
  - Code Book

HyperRESEARCH In Depth:
- Design:
  - Setting up your study
  - Preparing source material
- Coding:
  - Coding source material